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1 Introduction

Ce manuel explique l'installation, la configuration et l'utilisation du module de paiement pour
OpencCart et Stripe.

Avant de commencer l'installation, s'il vous plait assurer-vous que vous étes en possession de
toutes les données nécessaires:

Stripe Public Key

Stripe Secret Key

OpenCart module de paiement par sellxed.com/shop
Données d'accés a votre serveur et boutique

Veuillez noter que nos plugins nécessitent l'utilisation de PHP version 5.6 au minimum. PHP 8 ou
supérieur n'est actuellement pas pris en charge.

1.1 Processus de l'installation

Dans ce document, vous trouverez toutes les informations importantes pour l'installation du
module. Il est important que vous suivez strictement la check-list. Cela garantit une utilisation
du module en sécurité dans le respect des tous les réglements de Sécurité.
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1. Configuration du Module principale

2. Configuration des méthodes de paiement acceptés ainsi que les méthodes d'autorisation

3. Réalisation d'un achat test
4. Activez de votre compte Stripe

Installation

Par défaut, nos plugins de paiement possédent les paramétres corrects pour la plupart
de nos clients. Cela signifie une fois que vous ayez inséré les informations
d'identification requises dans la configuration du plugin, le plugin devrait étre
entierement opérationnel. Si vous souhaitez recevoir des informations détaillées sur un
parametre que vous ne connaissez pas, vous pouvez contacter notre support.

Si vous avez des problémes pendant l'installation, notre support sera la pour vous. Vous
pouvez nous contacter en cliquant sur le lien suivant: http://www.sellxed.com/support.
Vous avez aussi la possibilité de commander notre service d'installation. Nous
installerons sans problémes le plugin dans votre boutique. http://www.sellxed.com/shop
/de/integration-und-installation.html

Protection de dossier avec votre .htaccess

A fin d'utiliser ce module sans avoir des erreurs, les restrictions d'IP ou de dossiers
doivent étre désactivées. Ceci est nécessaire pour que la notification de paiement de
Stripe puisse atteindre votre boutique.
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2 Stripe Backend Configuration

Vous pouvez trouver un apercu des opérations et des parameétres dans le backend de Stripe:

® EnvironmentTest:https://dashboard. stripe.com | ogin
®* Environment Live :

2.1 Configuration du Module principale

Ceci est un petit guide d'installation des parameétres principaux et les plus importantes étapes
de I'installation. Il est important que vous suiviez strictement la liste de contr6le. En suivant la
liste correctement, l'utilisation sécurisée en correspondance avec tous les réglements de
Securité peut étre garantie.

® Aprés avoir ouvert votre compte sur Stripe, vous devrez insérer les données disponibles
sur Stripe dans le module principale.

® Copiezle Secret Key qui est visible dans votre compte Stripe sous Developers > API.

® (Copiezle Publishable Key qui est visible dans votre compte Stripe sous Developers > API.

® (Créezunnouveau Endpoint dans le backend de Stripe sous Developers > Webhooks et
insérez I'URL de redirection visible dans le tab ‘Setup’ du module.

® Quvrezles parameétres du Endpoint sur Stripe et ajoutez un Signing Key. Ce Signing Key doit
étre le méme que celui dans la configuration du module dans votre shop sous ‘Webhook
Secret’.

® (Cliquez sur‘Update Details' et activez le Endpoint pour les ‘Events’ suivants: charge.failed,
charge.succeeded, source.canceled, source.chargeable, source.failed

® QOptionnel: Sie vous utilisez SEPA, n'oubliez pas de configurer votre nom de marchand dans
la configuration.

2.2 Configuration des Méthodes de paiement

Les méthodes de paiement (Apple, Google, Microsoft Pay) ne sont supportées que sur les
appareils mobiles et avec les versions requises (0S et navigateur).

Pour plus d'informations sur la configuration des méthodes de paiement et de la signification de
chaque parameétre, cliquez ici. Aprés avoir activé et configuré les méthodes de paiement, vous
pouvez effectuer un test via les test data publiées dans le manuel. Si tous les essais ont réussis,
changez le mode de fonctionnement dans le module principal en Live.

2.3 Styling via Stripe.css

Il est possible de changer le formulaire avec CSS. Pour cela, veuillez éditer le fichier stripe.css
dans le modules de paiement. Le input style est défini dans .StripeElement et le container dans .
StripewWrapper. Pour plus d'informations veuillez cliquer sur ce lien.
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3 Installation du module dans la boutique
OpenCart

3.1 Installation

A ce moment, vous devriez déja étre en possession du module. Si cela ne serait pas le cas, vous
pouvez télécharger les fichiers nécessaires dans votre compte client dans le sellxed shop (Menu
"Mes téléchargements Téléchargements »). Pour télécharger le module dans votre magasin,
suivez les étapes suivantes:

1. Créez le back-up de votre boutique.

2. Extraire le contenu du fichier ZIP que vous avez téléchargé dans votre compte client.

3. Copiez le contenu entier du dossier «fichiers» dans le répertoire principal du serveur de
votre boutique respectivement au dossier dans lequel les plugins sont copiés
normalement. Pour ce faire, utilisez votre programme FTP habituel. Assurez-vous que les
dossiers ne sont pas remplacés, mais simplement fusionnés.

4. Sivous ne l'avez pas encore fait, connectez-vous dans votre boutique.

3.2 Miseajour

Pendant votre période de support, vous pouvez télécharger a tout moment les mises-a-jour du
module. Pour vous abonner aux mises-a-jour veuillez suivre les pas suivants: https://www.
sellxed.com/en/updates_upgrades.

3.2.1 Liste de contréle

N'oubliez pas de suivre les pas suivants avant la mise-a-jour:
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1. Créez un backup avant la mise-a-jour de votre systéme

2. Testez d'abbord la mise-a-jour sur un environnement de test. Nous testons nos modules
dans nos environnements de test, cependant des erreurs peuvent se passer avec d'autres
plugins dans votre boutique.

3. Continuez avec le téléchargement des fichiers sur votre serveur et ouvrez la configuration
principale du module. Sivous utilisez un cache, videz-le.

Quelques mises-a-jour doivent actualiser le schéma de quelques tables la base de donnée. Nous
vous conseillons d'actualiser le module pendant un certain temps ot vous n'avez pas beaucoup
de trafic sur le site.

Attention avec la mise a jour dans votre boutique de production

Si vous avez des problémes pendant la mise-a-jour, notre support sera la pour vous.
Pendant une mise-a-jour il peut y avoir un temps d'interruption, qui peut prendre jusqu'a
plusieures heures dans certains cas.

3.2.2 Instructions pour la mise-a-jour

Avant de faire la mise-a-jour, veuillez lire les étapes a suivre dans le Changelog qui se trouve
dans l'article du module dans notre boutique. Le module actualisera si nécessaire le schéma de
la base de donnée et des fichiers du module. Si rien n'est mentionné, vous pouvez simplement
écraser les fichiers sur le serveur pour completer la mise-a-jour.
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4 Configuration du module dans la boutique
OpenCart

La configuration consiste en deux étapes.La premiére étape correspond a la configuration du
module principal avec tous les réglages de base (cf. Configuration du module principal). Au cours
de la deuxiéme étape, vous pouvez alors effectuer configurations individuelles pour chaque
méthode de paiement . Ceci permet une flexibilité totale et une adaptation parfaite a vos
processus.

Créez des back-ups!

Créez un back-up du répertoire principal de votre boutique. En cas de probléme, vous
sereztoujours en mesure de retourner votre boutique a son état original.

Nous recommandons en outre de tester l'intégration sur un systéme de test. Des
complications peuvent survenir avec des modules tiers installés par vous. En cas de
questions, notre équipe de support est a votre entiére disposition.
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5 OpencCart 3.0 Installation - Additions

Afin de garantir le bon fonctionnement et utilisation de toutes les fonctionnalités assurez-vous
que vous suivez les instructions ci-dessous.

5.1 Configuration du module principal

Vous trouverez les parameétres pour le module principal dans "Extension > Modules > Stripe Base
Module" . Installez le module en cliqguant Installer.

En cliguant Modifier vous pouvez configurer le module principal. Insérez toutes les données dans
les champs correspondants. Les données nécessaires ont déja été enregistrées dans le back-
end de Stripe a été envoyé par Stripe. Chaque option est, en outre, expliquée dans des courts
textes d'informations dans la boutique.

5.2 >Definir 'URL pour le Feedback Transaction

Pour assurer un traitement de paiement correct dans votre boutique, au moins un Feedback URL
doit étre fourni pendant la configuration de Stripe . L'URL & saisir peut étre trouvé dans votre
boutique OpenCart dans le menu Extensions > Modifications > Modules > Stripe Base Module >
Edit > More > Setup.

5.3 Configuration du module de paiement

Aprés avoir réussi a configurer le module principal, vous pouvez trouver les parameétres pour les
méthode de paiement individuelles dans votre boutique dans Extensions > Paiements . Chaque
méthode de paiement est listée individuellement. Installez les méthodes de paiement que vous
souhaitez offrir @ vos clients dans votre boutique. Vous pouvez effectuer des réglages individuels
pour chaque méthode de paiement et ainsi adapter de facon optimale les méthodes de
paiement a vos processus existants. Les options les plus centrales sont décrites plus en détail ci-
dessous..

En cliquant sur Installer la méthode de paiement est activée dans votre boutique. Cliquez
Modifier afin de modifier la configuration de la méthode de paiement.
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5.4 Débit direct

L'option "Capture" vous permet de spécifier si vous voulez débiter les paiements directement ou
sivous souhaitez les authorisé et le débit du paiement a une date postérieure.

En fonction de votre contrat d'acquisition, une réservation est garantie seulement pour une
période de temps spécifique. Si vous échouez a débiter le paiement dans ce délai, l'autorisation
peut donc plus étre garantie. De plus amples informations sur ce processus se trouve ci-dessous.

Différents parametres entre le backend de Stripe et le module

Les parameétres enregistrés dans les modules de paiement peuvent remplacer les
parametres enregistrés dansstripe.

5.5 Statutincertain

Vous pouvez spécifiquement étiqueter les commandes pour lesquelles la réception de I'argent
n'est pas garantie. Cela vous permet de contréler manuellement la commande avant I'expédition.

5.5.1 Définition du statut de la commande

Pour chaque mode de paiement, vous pouvez spécifier le statut vers lequel la commande doit
étre déplacée en fonction du statut de la réservation. C'est le statut initial de la commande.

5.6 Validation

Avec l'option «Validation», vous pouvez définir le moment ol le mode de paiement doit étre
rendu visible pour le client au cours du processus de commande. Ce parameétre est pertinent
pour les modules ol l'utilisation dépend de la conformité du client avec des conditions
préalables spécifiques. Par exemple, si un contrdle de solvabilité doit etre effectué ou si le mode
de paiement est disponible uniquement dans certains pays. Pour que la vérification de la
solvabilité ou la validation de I'adresse fonctionne également avec les caractéres européens, le
jeu de caractéres du "mode Blowfish" doit étre réglé sur "UTF-8" pour certains parametres PSP.

Vous avez le choix entre deux options:

* Validation avant la sélection de la méthode de paiement: Une vérification de validation est
effectuée avant que le client sélectionne la méthode de paiement. S'il ou elle ne satisfait
pas les conditions, la méthode de paiement ne sont pas affichées

¢ Validation aprés la sélection de la méthode de paiement: La vérification de la conformité a
lieu aprés la sélection de la méthode de paiement et avant la confirmation de la
commande

e Au cours de l'autorisation: La vérification de validation est effectuée par Stripe au cours de
la procédure d'autorisation. Le mode de paiement est affiché dans tous les cas
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6 Réglages / Configuration des Méthodes de
paiement

6.1 Informations générales sur les méthodes de paiement

Tous les modules de paiement sellxed sont livrés avec des méthodes de paiement les plus
courants. In case a desired payment method is not included per default, please contact us
directly.

Afin d'étre en mesure d'utiliser un méthode de paiement, il doit étre activé dans votre compte
Stripe ainsi que dans votre boutique. Les informations sur la configuration des méthodes de
paiement peuvent étre trouvé plus haut.

Ci-dessous vous trouverez des informations importantes pour les méthodes de paiement
spécifiques qui dérogent a la procédure standard.

6.2 Informations sur le statut du paiement

Pour chague méthode de paiement, vous pouvez définir les statuts a saisir aprés compléter une
transaction (statut pour les paiements autorisés, capturés etc.). Vous pouvez définir le statut de
la commande pour chaque statut de transaction different (par exemple: un statut pour un
capturé, autorisé, etc.).

Information importante concernant le statut de la commande

Ne définissez jamais un de vos status sur Pending Stripe ou tout autre statut similaire
quivient directement du module.

6.2.1 Statut de la commande "pending" / paiement imminent (ou similaire)

Les commandes avec le statut 'Pending Stripe' sont des commandes qui n'ont pas été terminées.
Les commandes recgoivent ce statut si un client est redirigé a la page de paiement, mais n'a pas
réussi a finir la son paiement ou la notification du paiement n'a pas encore atteint votre
boutique (Par exemple le client ferme la page de paiement et ne compléte pas le paiement).
Selon la méthode de paiement, ces commandes seront automatiquement transformées en
commandes annulées et I'inventaire sera corrigé (un cronjob doit étre activé). La durée de ce
changement automatique dépend des caractéristiques de la méthode de paiement. Cela ne peut
pas étre configure.

Si vous avez beaucoup de commandes sans avoir été finalisées, cela signifie g¢énéralement que
les notifications de votre serveur Web a Stripe sont bloquées. Dans ce cas, veuillez vérifier les
parameétres de votre firewall et demandez a votre hébergeur d'accepter les IP et les User Agent
de Stripe.
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6.2.2 Statut de commande "annulé"

Les commandes avec le statut "annulé" ont recu ce statut automatiquement a cause d'un délai
d'expiration, comme décrit ci-dessus, ou ont été annulées directement par le client.
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7 Le module en action

Ci-dessous vous trouverez un apercu des caractéristiques les plus importantes dans l'utilisation
quotidienne du module Stripe .

7.1 Données de transaction des commandes

Vous pouvez trouver un résumé des données de transactions les plus importantes pour toutes
les commandes passées via notre module. L'ensemble des données de transaction permettent
['attribution des commandes avec les transactions correspondantes sur votre compte Stripe.

[E] orders

Order Detalls Grder D 2

Invoice No [ Generate ]

Payment Details

Shipping Detalls Store Name Your Store

: D: X £ .
Products Store Url. hitp:lidemo.sellxed.com

Customer. Sascha krisi

History

Customer Group: Default

E-Mail: info@customweb.ch

Telephone 33123456798

Total: 78.90€

Order Status: Pending

IP Address: 1608515547

User Agent Mozilla/5.0 (X11; Linux x86_64) AppleWebKit/537 36 (KHTML, like Gecko) Ubuntu Chromium/30.0.1589.114 Chrome/30.0.1598.114 Safari/537 36
Accept Language: de,en-US;g=0.8.en,q=0.6

Date Added. 13/11/2013

Date Modified: 13M11/2013

Image 7.1: Données de transaction sur OpencCart.

7.2 Utilisation Alias Managers / Token Solution

Avec |' Alias Manager, vos clients peuvent en toute sécurité sauvegarder leurs cartes de crédit
avec Stripe pour les achats ultérieurs. L'utilisation est activé en sélectionnant I'option "Alias
Manager" dans la configuration de Payment. Le client peut alors choisir parmi ses cartes de
crédit enregistrées sans avoir a entrer de nouveau tous les détails.
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Use Stored Card | ooooooooox 0111 7

Card Holder Name*  Sascha krusi

Please enter here the card holder name on the card.

Card Number* 0000 0000 00 0111
Please enter here the number on your card.

Card Expiration® 12 Y 2015 ¥

Select the date on which your card expires.

CVC Code*

Please enter here the CVC code from your card. You find the code on the back of the card.

Confirm Order

Image 7.1: Alias Manager

Alias Manager Options

L'utilisation de I' Alias Managers nécessite l'activation de l'option correct avec Stripe.
Pour le mettre en place contactez notre support.

7.3 Débit / annulation de commandes

7.3.1 Capturer les commandes

Afin de capturer les commandes, ouvrir les informations de transaction dans Sales > Stripe .
Vous trouverez ici un apercu de toutes les transactions.Vous y trouverez des informations sur la
transaction. En cliquant sur "vue" vous ouvrirez la transaction de l'ordre.

7.3.1.1 Capture commandes complétes ou la capture partielle

En cliqguant sur le bouton "Capture Transaction" une nouvelle fenétre s'ouvre. Vous pouvez
maintenant capturer chaque élément individuellement au cas ot vous ne souhaitez pas envoyer
tous les éléments a la fois. La quantité de possibles captures partielles dépend de votre contrat.
Contactez Stripe directement pour clarifier vos questions.

Capture des commandes dans le back-end de Stripe

La gestion des transactions entre votre boutique et Stripe n'est pas synchronisée. Si vous
capturez des paiements avec Stripe, le statut dans la boutique ne sera pas mis a jour et
une seconde capture dans la boutique n' est pas possible.

Au cas ol vous ne souhaitez pas capturer tous les éléments d'une commande, vous pouvez
fermer la transaction en cliquant sur la boite.
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With the following form you can perform a partial capture.

Name SKU Type Tax Rate
iPhone product 11 product 0%
Flat Shipping Rate shipping shipping 0%

Image 7.1: Capture des commandes

Capture Partiel

Quantity Total Amount (excl. Tax) Total Amount (incl. Tax)
1 | 74.24 | 74.24
1 | 3.68 | 3.68

Total Capture Amount: 77.91 EUR

Close transaction for further captures

Capture

Vérifiez si la capture de quantités partielles est pris en charge avec votre contrat avec
Stripe . Si cela est le cas, que la transaction soit fermée pour de nouvelles opérations

aprés une capture partielle.

7.3.2 Annuler les commandes

En cliquant "Annuler la Transaction”, la transaction est annulé et le montant de la réserve sur la

carte de votre client est automatiquement rendu.

Capture Transaction

Image 7.1: Capturer ou Annuler in OpencCart.

7.4 Remboursement des commandes

Refund Transaction

Afin de rembourser les commandes, ouvrir les informations de transaction (cf. above).

Vous pouvez rembourser des éléments individuels ou tout montant de votre choix en modifiant

la quantité totale ou la quantité d'articles.
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PARTIAL REFUND

With the following form you can perform a partial refund.

MName SKU Type Tax Rate Quantity Total Amount (exel. Tax) Total Amount (incl. Tax)

iPhone product11  product 0% | 1 | 74.24 [ 7424

Flat Shipping Rate shipping shipping 0% I 1 I 3.68 I 368
Total Refund Amount: 7791 EUR

Close transaction for further refunds

Image 7.1: Remboursement OpenCart pour Stripe.

Remboursement maximal

Avec notre module il est impossible de rembourser plus de 100% du montant autorisé
initialement.

7.5 Mise en place d'un cron job pour activer les opérations
chronomeétrées

Pour activer les opérations chronométrées du plugin (e.g. update service, deleting pending
orders, etc.) assurez vous que vous avez activé le Cron Engine de OpenCart . En particulier, la
fonction de mise a jour vous permet de récupérer automatiquement des informations
supplémentaires ou change votre commande directement via I'API deStripe. Pour utiliser la
fonction mise a jour, peut etre que Stripe doit activer des options supplémentaires dans votre
compte.

Pour utiliser les opérations chronomeétrées, planifiez un cron job dans votre server pour le
controller suivant:

https://www.your-shop.com/index.php?route=stripecw/cron/cron

0On vous conseille d'utiliser un Cron Engine come par example EasyCron. De cette fagon, vous
pouvez Cela vous permet d'ouvrir le fichier (URL) avec un service externe.
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Avant de passer au mode productif, vous devez tester le module.

Apreés vos tests

N'oubliez pas de changer au mode productif aprés avoir fini vos tests.

8.1 Données de test

Voici les donnés de test:
Credit / Debit Card

Kartennummer
Expiry Date
cvc

Kartennummer
Expiry Date
cvc

Kartennummer
Expiry Date
cvc

Kartennummer
Expiry Date
cvc

Kartennummer
Expiry Date
cvc

Kartennummer
Expiry Date
cvc

Kartennummer
Expiry Date
cvc

Kartennummer
Expiry Date
cvc

Kartennummer
Expiry Date
cvc

Kartennummer

L42L2424242424242
12/2020
123

4000056655665556
12/2020
123

5555555555554444
12/2020
123

5200828282828210
12/2020
123

378282246310005
12/2020
123

371449635398431
12/2020
123

6011111111111117
12/2020
123

6011000990139424
12/2020
123

3530111333300000
12/2020
123

3566002020360505

VISA

VISA Debit

MasterCard

MasterCard Debit

American Express 1

American Express 2

Discover 1

Discover 2

JCB1

JCB 2
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Expiry Date
cvc

Kartennummer
Expiry Date
cvc

Kartennummer
Expiry Date
cvc

Visa
Kartennummer
Expiry Date
cvc

Kartennummer
Expiry Date
Ccvc

MasterCard
Kartennummer
Expiry Date
cvc

Kartennummer
Expiry Date
cvc

American Express
Kartennummer
Expiry Date

Ccvc

Kartennummer
Expiry Date
cvc

Discover Card
Kartennummer
Expiry Date
cvc

Kartennummer
Expiry Date
cvc

JCB
Kartennummer
Expiry Date
cvc

12/2020
123

30569309025904
12/2020
123

38520000023237
12/2020
123

L2L24L24242424242
12/2020
123

4000056655665556
12/2020
123

5555555555554444
12/2020
123

5200828282828210
12/2020
123

378282246310005
12/2020
123

371449635398431
12/2020
123

6011111111111117
12/2020
123

6011000990139424
12/2020
123

3530111333300000
12/2020
123

sellxed

Diners 1

Diners 2

VISA

VISA Debit

MasterCard

MasterCard Debit

American Express 1

American Express 2

Discover 1

Discover 2

JCB1
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Kartennummer 3566002020360505 82
Expiry Date 12/2020

cvc 123

Diners Club

Kartennummer 30569309025904 Diners 1
Expiry Date 12/2020

Ccvc 123

Kartennummer 38520000023237 Diners 2
Expiry Date 12/2020

cvc 123
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9 Erreurs et solutions

Vous trouverez notre FAQ avec les erreurs et leurs solutions sous http://www.Ssellxed.com/en/faq
. Si le probléme n'est pas résolu, vous pouvez contacter notre support sous: http://www.sellxed.
com/en/support

9.1 L'URL'Referrer' apparait dans Analytics

Dans certains cas, les URL's 'Referrer' sont falisifée par Stripe dans Analytics. Cela se passe
quand le client envoie une 'Header Redirection'. Cela peut étre résolu dans la configuration de
votre systéme Analytics.

Pour Google Analytics, un example pour PayPal ce trouve ici.
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http://www.optimizesmart.com/tracking-true-referrals-in-google-analytics-when-using-paypal-and-other-payment-gateways/
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